Notice
The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.
©February 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.
Intel Core is a trademark/registered trademark of Intel Corporation.
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord indicated in this manual.
5. This product is intended to be supplied by a Listed Power Unit - Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz / DC Output 20V, 9.0A (180W).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
Instructions for Care and Operation

The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don't drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

2. **Keep it dry, and don’t overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost.

5. **Take care when using peripheral devices.**
Power Safety
The computer has specific power requirements:

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
• Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power supplies.

Do not plug in the power cord if you are wet.

Do not use the power cord if it is broken.

Do not place heavy objects on the power cord.

Power Safety Warning
Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines).
Preface

Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord is damaged or frayed.
• If the computer has been exposed to any liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.
Ergonomics

We designed your Multimedia PC system to be functional as well as attractive. To get most out of it, here are some suggestions on how to position and use the computer:

• The top third of the LCD (screen) should be at eye-level or slightly below.

• The LCD should be at least 18”/45cm. directly in front of you.

• If the screen resolution (e.g. 1024x768) makes you strain to read, change it: In Windows Control Panel, double-click Display (icon) and click Settings (tab). Then adjust the “Screen area” to something more comfortable (e.g. 800x600).

• Angle the LCD (see “Tilting the LCD Screen” on page 1 - 10) so that it doesn’t reflect any light into your eyes.

• Use a chair which offers good back support (especially lower-back). The seat should allow your feet to rest flat on the floor or on a footrest directly in front of you.

• If possible, illuminate your work area with natural daylight or use a steady-glowing (non-flickering) light source.

• Place the keyboard and mouse so that your arms are at your sides and your forearms are roughly parallel to the floor. Your wrists should flex slightly downward as you work. Your neck and shoulders should also be relaxed.

• Take a break from the computer. Get up, stretch, flex your wrists, walk about, and look at something else for about 10 minutes every hour.
Contents

Notice .................................................................................I
FCC Statement .............................................................II
Instructions for Care and Operation .......................IV
Power Safety ............................................................... V
Cleaning .....................................................................VI
Servicing .................................................................... VI
Ergonomics ....................................................................VII
Quick Start Guide
Overview ........................................................................1-1
Model Differences .........................................................1-2
Advanced Users .............................................................1-4
Beginners and Not-So-Advanced Users ..................1-4
Warning Boxes ..............................................................1-4
Not Included .................................................................1-5
System Software ............................................................1-6
System Startup ..............................................................1-7
System Map: Front View & Top View (Model A) ........1-8
System Map: Front View & Top View (Model B) ........1-9
Tilting the LCD Screen ................................................1-10
Moving the Computer ..................................................1-11
Wall Mounting Information ..........................................1-11
LED Indicators .............................................................1-12
System Map: Right View ..............................................1-13
System Map: Left View ...............................................1-14
System Map: Rear View ..............................................1-15
Audio/Video Jacks .......................................................1-16
Windows Vista Start Menu & Control Panel ...............1-17
Video Features ............................................................1-18
Power Options .............................................................1-20
Features & Components
Overview ........................................................................2-1
Hard Disk Drive ............................................................2-2
Optical (CD/DVD) Device ............................................2-3
Loading Discs ...............................................................2-3
Handling CDs or DVDs ...............................................2-4
DVD Regional Codes ...................................................2-5
7-in-1 Card Reader ........................................................2-6
ExpressCard Slot .........................................................2-7
Inserting and Removing ExpressCards .......................2-7
Audio Features ............................................................2-8
Hot Key Buttons ...........................................................2-9
Application Hot Key .....................................................2-10
Adding a Printer ...........................................................2-11
USB Printer ...............................................................2-11
## Preface

Parallel Printer ............................................................. 2-11

### Power Management

Overview ................................................................. 3-1
Turning on the Computer ........................................... 3-2
Power Plans ............................................................... 3-3
System Power Options .............................................. 3-5
Hibernate vs. Shut Down .......................................... 3-5
Sleep vs. Hibernate .................................................. 3-5
Sleep .......................................................................... 3-6
Hibernate ................................................................. 3-6
Configuring the Power Button ................................... 3-7

### Drivers & Utilities

RAID & AHCI Setup .................................................. 4-1
What to Install ........................................................ 4-1
Driver Installation .................................................... 4-2
Updating/Reinstalling Individual Drivers .................... 4-3
Manual Driver Installation ....................................... 4-4
User Account Control (Win Vista) ............................. 4-5
Windows Security Message ..................................... 4-5
New Hardware Found .............................................. 4-5
Chipset ...................................................................... 4-5
Intel Video ............................................................... 4-5
NVIDIA Video .......................................................... 4-5

## BIOS Utilities

Overview ................................................................. 5-1
The Power-On Self Test (POST) ................................. 5-2
Failing the POST ..................................................... 5-2
Fatal Errors ............................................................. 5-2
Non-Fatal Errors ...................................................... 5-3
The Setup Program ................................................ 5-4
Entering Setup ........................................................ 5-4
Setup Screens ......................................................... 5-5
Main Menu ............................................................. 5-6
Preface

System Time & Date (Main Menu) ........................................... 5-6
Installed Memory/Available to OS/
Used by devices (Main Menu) ........................................... 5-6
Advanced Menu .................................................................. 5-7
Chipset Information Menu (Advanced Menu) .................. 5-7
Reset Configuration Data: (Advanced Menu) .................. 5-8
Legacy USB Support: (Advanced Menu) ......................... 5-8
Boot-time Diagnostic Screen: (Advanced Menu) .......... 5-8
Energy Lake: (Advanced Menu) ....................................... 5-8
IGD Memory Size (Advanced Menu >
Advanced Chipset Control) ............................................ 5-9
SATA RAID Enable: (Advanced Menu) ......................... 5-9
SATA AHCI Enable: (Advanced Menu) ......................... 5-9
Security Menu ................................................................... 5-10
Set Supervisor Password (Security Menu) .................... 5-10
Fixed disk boot sector: (Security Menu) ....................... 5-11
Password on boot: (Security Menu) ............................ 5-11
Boot Menu ................................................................... 5-12
Exit Menu ................................................................... 5-13

Upgrading The Computer
Overview ................................................................. 6-1
When Not to Upgrade ...................................................... 6-2
Upgrading the Hard Disk Drive(s) ................................... 6-3
Upgrading the System Memory (RAM) .......................... 6-6
Upgrading the Processor ................................................ 6-10

Modules
Overview ....................................................................... 7-1
Setting Up SATA RAID or AHCI Modes ................. 7-2
Intel Matrix .................................................................... 7-6
Wireless LAN Modules ................................................. 7-7
WLAN Driver Installation ............................................. 7-7
Connecting to a Wireless Network ......................... 7-8
Bluetooth Module ......................................................... 7-11
Bluetooth Driver Installation .................................... 7-11
Remote Control Unit ..................................................... 7-13
Consumer Infrared Driver Installation .................... 7-13
Hybrid Mini-PCI TV Tuner Module ......................... 7-15
MPC788/MPC718 Driver & Software ....................... 7-16
Digital TV Broadcast Signal ..................................... 7-17
TV Recording and Power Schemes ......................... 7-17
PC Camera Module ..................................................... 7-18
PC Camera Driver Installation .................................... 7-18
PC Camera Audio Setup .............................................. 7-19
BisonCam ..................................................................... 7-21
Eliminating Screen Flicker ........................................... 7-22
Wireless Keyboard & Mouse Kit ......................... 7-23
Wireless Kit Hardware Setup .................................... 7-24
Wireless Kit Driver ...................................................... 7-26
Preface

Troubleshooting
Overview ................................................................. 8-1
Basic Hints and Tips .................................................. 8-2
Backup and General Maintenance .............................. 8-3
Viruses .................................................................... 8-4
Upgrading and Adding New Hardware/Software ......... 8-5
Problems and Solutions .............................................. 8-7

Intel Video Driver Controls
Video Driver Installation ........................................... B-1
Intel Video ................................................................. B-1
Dynamic Video Memory Technology ......................... B-1
Intel GMA Driver Controls ......................................... B-2
Scheme Options ......................................................... B-4

NVIDIA Video Driver Controls
Video Driver Installation ........................................... C-1
NVIDIA Video ............................................................ C-1
NVIDIA Control Panel ............................................... C-2

Specifications
Processor ..................................................................... D-2
Core Logic ................................................................... D-2
Memory ........................................................................ D-2
Security ........................................................................ D-2
BIOS ........................................................................... D-2
LCD .............................................................................. D-2
Video Adapter Options .............................................. D-3
Storage ........................................................................ D-3
Audio ........................................................................... D-3
Keyboard & Pointing Device ...................................... D-3
ExpressCard Slot ....................................................... D-3

Interface (Ports & Jacks)
Overview ..................................................................... A-1
Ports and Jacks .......................................................... A-2
Card Reader Port ......................................................... A-2
DC-In Jack ................................................................... A-2
E-SATA Port ............................................................... A-2
Headphone-Out Jack (Green) ..................................... A-2
Line-In Jack (Blue) ..................................................... A-2
Microphone-In Jack (Pink) ......................................... A-2
RJ-11 Phone Jack ....................................................... A-3
Mini-IEEE 1394 Port .................................................. A-3
RJ-45 LAN Jack .......................................................... A-3
Security Lock Slot ...................................................... A-3
S/PDIF-Out Jack ........................................................ A-3
USB 2.0/1.1 Ports ....................................................... A-4
Audio/Video Jacks ...................................................... A-5
<table>
<thead>
<tr>
<th>Interface</th>
<th>D-4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader</td>
<td>D-4</td>
</tr>
<tr>
<td>Communication</td>
<td>D-4</td>
</tr>
<tr>
<td>Power Management</td>
<td>D-4</td>
</tr>
<tr>
<td>Power</td>
<td>D-5</td>
</tr>
<tr>
<td>Environmental Spec</td>
<td>D-5</td>
</tr>
<tr>
<td>Physical Dimensions &amp; Weight</td>
<td>D-5</td>
</tr>
<tr>
<td>Optional</td>
<td>D-5</td>
</tr>
<tr>
<td><strong>Windows XP Information</strong></td>
<td></td>
</tr>
<tr>
<td>DVD Regional Codes</td>
<td>E-2</td>
</tr>
<tr>
<td>Windows XP Start Menu &amp; Control Panel</td>
<td>E-3</td>
</tr>
<tr>
<td>Audio Features</td>
<td>E-4</td>
</tr>
<tr>
<td>Hot Key Buttons</td>
<td>E-5</td>
</tr>
<tr>
<td>Application Hot Key</td>
<td>E-6</td>
</tr>
<tr>
<td>Video Features</td>
<td>E-7</td>
</tr>
<tr>
<td>Intel Video Driver Controls</td>
<td>E-9</td>
</tr>
<tr>
<td>Video Driver Installation</td>
<td>E-9</td>
</tr>
<tr>
<td>Intel Video</td>
<td>E-9</td>
</tr>
<tr>
<td>Dynamic Video Memory Technology</td>
<td>E-9</td>
</tr>
<tr>
<td>Intel GMA Control Panel</td>
<td>E-10</td>
</tr>
<tr>
<td>Scheme Options</td>
<td>E-12</td>
</tr>
<tr>
<td>NVIDIA Video Driver Controls</td>
<td>E-13</td>
</tr>
<tr>
<td>Video Driver Installation</td>
<td>E-13</td>
</tr>
<tr>
<td>NVIDIA Video</td>
<td>E-13</td>
</tr>
<tr>
<td>NVIDIA nView Desktop Manager</td>
<td>E-15</td>
</tr>
<tr>
<td>Power Management</td>
<td>E-16</td>
</tr>
<tr>
<td>Power Schemes</td>
<td>E-17</td>
</tr>
<tr>
<td>System Power Options</td>
<td>E-18</td>
</tr>
<tr>
<td>Hibernate Mode vs. Shutdown</td>
<td>E-18</td>
</tr>
<tr>
<td>Standby Mode vs. Hibernate Mode</td>
<td>E-18</td>
</tr>
<tr>
<td>Standby</td>
<td>E-19</td>
</tr>
<tr>
<td>Hibernate</td>
<td>E-19</td>
</tr>
<tr>
<td>Configuring the Power Button</td>
<td>E-20</td>
</tr>
<tr>
<td>Driver Installation</td>
<td>E-21</td>
</tr>
<tr>
<td>What to Install</td>
<td>E-22</td>
</tr>
<tr>
<td>Updating/Reinstalling Individual Drivers</td>
<td>E-23</td>
</tr>
<tr>
<td>New Hardware Found</td>
<td>E-24</td>
</tr>
<tr>
<td>Driver Installation Procedure</td>
<td>E-24</td>
</tr>
<tr>
<td>Chipset</td>
<td>E-24</td>
</tr>
<tr>
<td>Intel Video</td>
<td>E-25</td>
</tr>
<tr>
<td>NVIDIA Video</td>
<td>E-25</td>
</tr>
<tr>
<td>Audio</td>
<td>E-25</td>
</tr>
<tr>
<td>Modem</td>
<td>E-26</td>
</tr>
<tr>
<td>LAN</td>
<td>E-26</td>
</tr>
<tr>
<td>CardReader</td>
<td>E-27</td>
</tr>
<tr>
<td>JMicron (for E-SATA)</td>
<td>E-27</td>
</tr>
<tr>
<td>Hot Key</td>
<td>E-27</td>
</tr>
<tr>
<td>Module Drivers</td>
<td>E-27</td>
</tr>
<tr>
<td>Wireless LAN Modules</td>
<td>E-28</td>
</tr>
</tbody>
</table>
Preface

Intel WLAN Driver Installation .................................. E-29
802.11 b/g USB Wireless LAN Driver Installation .... E-30
Peer to Peer Network Setup ....................................... E-31
Bluetooth Module .................................................. E-33
Bluetooth Driver Installation ...................................... E-33
Remote Control Unit ................................................ E-35
Consumer Infrared Driver Installation ........................ E-35
Hybrid Mini-PCI TV Tuner Module .......................... E-37
Installing the MPC788 Driver &
Cyberlink PowerCinema ............................................. E-37
PC Camera Module ..................................................... E-38
PC Camera Driver Installation ..................................... E-38
PC Camera Audio Setup ............................................. E-39
Bison Cap ................................................................. E-41
Eliminating Screen Flicker ........................................ E-42
Wireless Keyboard & Mouse Kit ............................... E-43
Wireless Kit Driver ..................................................... E-43
Setting Up SATA RAID or AHCI Modes .................. E-44
RAID Mode ................................................................ E-44
AHCI Mode ............................................................. E-44
Intel Matrix Driver Installation .................................. E-50
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• **Chapter 2** A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 7-in-1 card reader, ExpressCard), Audio & Printer.
• **Chapter 3** The computer’s power management options.
• **Chapter 4** The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
• **Chapter 5** An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• **Chapter 6** Instructions for upgrading your computer.
• **Chapter 7** A quick guide to the computer’s SATA RAID, Wireless LAN, Bluetooth, PC Camera, TV Tuner and Wireless Kit modules (some of which are optional depending on your purchase configuration).
• **Chapter 8** A troubleshooting guide.
• **Appendix A** Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
• **Appendix B** Information on the Intel Video driver controls.
• **Appendix C** Information on the NVIDIA Video driver controls.
• **Appendix D** The computer’s specification.
• **Appendix E** Information on the Window’s XP OS.
Model Differences
This computer series includes two different model types based upon the size of LCD screen. The models are otherwise identical in appearance, ports and features etc.

Both models feature EITHER integrated Intel video, OR an NVIDIA video card, depending on your purchase option.

Both models may have an optional RF keyboard (factory option only) and mouse supplied, if included in your purchase option.

Both models may be supplied with an optional Mini-PCI TV Tuner module. This allows the computer to function as a multimedia entertainment center, allows you to watch cable and air television channels (digital and analog). The Hybrid Mini-PCI TV Tuner is supplied with a remote control unit which gives you full control over the multimedia features of the computer.
## Table 1 - 1 - Model Differences

*See “Specifications” on page D - 1 for full details.
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1. You may also find the notes marked with a of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the symbol. Also please note the safety and handling instructions as indicated in the Preface.

1 - 4 Overview
Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “What to Install” on page 4 - 1 for installation instructions.

Ports and Jacks
See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find the following operating systems are supported.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Windows XP (32-bit) Home &amp; Professional Editions with Service Pack 2</td>
<td></td>
</tr>
<tr>
<td>Windows Vista (64-bit) Home Basic Edition</td>
<td>In order to run Windows Vista without limitations or decreased performance, your computer requires a minimum 1GB of system memory (RAM).</td>
</tr>
<tr>
<td>Windows Vista (64-bit) Home Premium Edition</td>
<td></td>
</tr>
<tr>
<td>Windows Vista (64-bit) Business/ Enterprise/ Ultimate Edition</td>
<td></td>
</tr>
</tbody>
</table>

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page E - 1.
System Startup

1. Remove all packing materials, CDs/DVDs and floppy disks etc.
2. Securely attach any peripherals you want to use with the computer to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
4. Push the power button 1 to turn the computer “on”.

*Figure 1 - 1 - Power Button Location*
Quick Start Guide

System Map: Front View & Top View (Model A)

1. Optional Built-In PC Camera
2. Power LED
3. Consumer Infrared Transceiver
   (Communicates with Optional TV Remote)
4. LCD
5. LED Indicators
6. Speakers
7. Power Button
8. Brightness Hot Key Button*
9. Application Hot Key Button*

*Requires Hot Key Driver

Figure 1 - 2 - Front View (Model A)
System Map: Front View & Top View (Model B)

1. Optional Built-In PC Camera
2. Power LED
3. Consumer Infrared Transceiver
   (Communicates with Optional TV Remote)
4. LCD
5. LED Indicators
6. Speakers
7. Power Button
8. Brightness Hot Key Button*
9. Application Hot Key Button*

*Requires Hot Key Driver

Figure 1 - 3 - Front View (Model B)
Tilting the LCD Screen

It is possible to adjust the angle of the LCD screen in order to get the best possible view without glare etc.

1. Make sure the computer is sitting on a flat even surface.
2. Grip the computer at the top of the screen with one hand, and use the other hand to pull the stand out until you hear a click (at about 40 degrees).
3. The screen angle can safely be adjusted by pushing it back from the top of the screen to tilt it to the appropriate viewing angle (the stand will push back from 40 degrees to about 90 degrees).

Figure 1 - 4 - Tilting The Screen

Stand Position

The stand position may be adjusted between 40 and 90 degrees. DO NOT PLACE THE STAND IN THE UPRIGHT TRANSPORT POSITION AS IT IS VERY UNSTABLE, and not suitable for viewing.
Moving the Computer
We strongly recommend using both hands to move the computer. You can use one hand to grip the computer by the stand, and the other to hold the top of the LCD screen. The computer may be transported in the upside down position by using the stand as a handle, but using both hands to carry it.

It is recommended that you carry the computer with the LCD facing your body to avoid scratching the surface against other objects. However take care not to scratch the LCD with any personal items, belt fittings or jewelry etc. (one hand gripping the stand and the other gripping the top of the computer to avoid accidentally dropping it).

Wall Mounting Information
The computer may be mounted on a wall for display. The system meets VESA (FDMI) Standard (100mm * 100mm) for wall mounting. However if you intend to wall mount the system please contact your service center for information in order to avoid personal injury, or damage to the computer.
LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Green</td>
<td>The computer is On</td>
</tr>
<tr>
<td></td>
<td>Blinking Green</td>
<td>The computer is in Sleep</td>
</tr>
<tr>
<td></td>
<td>Orange</td>
<td>The AC/DC Adapter is Plugged in &amp; the Computer is Powered Off</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>System Activity</td>
</tr>
<tr>
<td></td>
<td>Green</td>
<td>The Optional WLAN Module is Installed</td>
</tr>
<tr>
<td></td>
<td>Orange</td>
<td>The Optional Bluetooth Module is Installed</td>
</tr>
<tr>
<td></td>
<td>Green/Orange</td>
<td>Both the Optional WLAN Module and Optional Bluetooth Module are Installed</td>
</tr>
</tbody>
</table>
CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or similar object that may break and become lodged in the hole.

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

Changing DVD Regional Codes

Go to the Control Panel and double-click Device Manager (Hardware and Sound) and then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up Properties, and select the DVD Region (tab). This control panel allows you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
System Map: Left View

ExpressCard Slot
The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.

Mini-IEEE 1394 Port
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.

7-in-1 Card Reader
The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)
- MS Duo (requires PC adapter)
- Mini SD (requires PC adapter)
- RS MMC (requires PC adapter)
Quick Start Guide

System Map: Rear View

Figure 1 - 7 - Rear View

1. Camera Angle Switch
2. USB Port Cover (see pages 7 - 24 & A - 4)
3. Module Cover
4. Rear Component Cover
5. 3 * USB 2.0 Ports
6. 1 External SATA Port
7. DC-In Jack
8. Audio/Video Jacks (See over)
9. RJ-11 Phone Jack
10. RJ-45 LAN Jack
11. Stand
12. Vent/Fan Intake/Outlet
13. Hard Disk Covers
14. Cable Holders (To Secure Audio/Video/USB Cables etc.)

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
Audio/Video Jacks

**Figure 1 - 8 - Audio/Video Jacks**

<table>
<thead>
<tr>
<th>Port/Jack</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 S-Video-In Jack</td>
<td>Connect an <strong>S-Video</strong> Cable to this Jack to Display External Video Sources on the LCD</td>
</tr>
<tr>
<td>2 Right &amp; Left Audio-In Jacks</td>
<td>Connect <strong>Analog Audio</strong> Cables to Play External Audio Sources Through the Computer’s Speakers</td>
</tr>
<tr>
<td>3 Composite Video-In Jack</td>
<td>Connect a <strong>Composite Video</strong> Cable to this Jack to Display External Video Sources on the LCD</td>
</tr>
<tr>
<td>4 CATV-In (Coaxial) Jacks (for TV Tuner Option Only)</td>
<td>Connect a <strong>CATV Cable or Digital Aerial</strong> to Display Cable TV Pictures on the LCD</td>
</tr>
</tbody>
</table>

**Table 1 - 4 - Jack Connections**

**CATV Cable Safety**
Make sure that your CATV system installer has connected the coaxial cable shield to the grounding system of the building, as close to the point of cable entry as practical.
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon, and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.
Quick Start Guide

Video Features

This computer features either Intel integrated video, or an NVIDIA PCI Express discrete video, depending on your purchase option (see “Video Adapter Options” on page D - 3). You can configure display options, from the Display Settings control panel in Windows as long as the appropriate video driver is installed. For more detailed video information see “Intel Video Driver Controls” on page B - 1 or “NVIDIA Video Driver Controls” on page C - 1. To access Display Settings in Windows Vista:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution: (Figure 1 - 10 on page 1 - 19).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 10 on page 1 - 19).
5. Click Advanced Settings (button) (Figure 1 - 10 on page 1 - 19).

For Intel GMA
1. Click Intel(R) Graphics Media Accelerator (tab).
2. Click Graphics Properties (button) (Figure 1 - 10 on page 1 - 19) to access the Intel GMA Control Panel.
3. The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

For NVIDIA GeForce Go
1. Click GeForce Go.... (tab).
2. Click Start the NVIDIA Control Panel (Figure 1 - 10 on page 1 - 19) to access the control panel.
3. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel.
Figure 1 - 10 - Display Settings
Quick Start Guide

Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 17) allows you to configure power management features for your computer. You can conserve power by means of power plans and configure the options for the power button, sleep button, display and sleep mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration options. See “Power Management” on page 3 - 1 for more details.

Note: Sleep is the default power saving state in Windows Vista

Figure 1 - 11 - Power Options

1 - 20 Power Options
Chapter 2: Features & Components

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical (CD/DVD) Device
- 7-in-1 Card Reader
- ExpressCard Slot
- Audio Features
- Hot Key Buttons
- Adding a Printer
Features & Components

Hard Disk Drive

The hard disk drive(s) is(are) used to store your data in the computer. The hard disk(s) can be taken out to accommodate other 3.5" serial (SATA) hard disk drives with a height of 26mm(h). If you have included the 2nd RAID SATA HDD option see “Setting Up SATA RAID or AHCI Modes” on page 7 - 2 for instructions on configuring the system.

Figure 2 - 1
Hard Disk Location
Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you purchased (see “Storage” on page D - 3). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment
How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting (see “Audio Features” on page 2 - 8).
Handling CDs or DVDs

Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.
### DVD Regional Codes

To change the DVD regional codes see "Changing DVD Regional Codes" on page 1 - 13.

**Table 2 - 1**

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

**Figure 2 - 3**

DVD Regions
7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the Card Reader Card driver (see “Card Reader” on page 4 - 6).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)
- MS Duo (requires PC adapter*)
- Mini SD (requires PC adapter*)
- RS MMC (requires PC adapter*)

*Note: The PC adapters are usually supplied with these cards.
ExpressCard Slot

The computer is equipped with an **ExpressCard/34/54** slot that reads Express Card/34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g. CompactFlash card reader. The number denotes the card width; 54mm for the Express Card/54 and 34mm for the ExpressCard/34.

**Inserting and Removing ExpressCards**

- Align the ExpressCard with the slot and push it in until it locks into place.
- To remove an ExpressCard, simply press the card to eject it.

ExpressCard Slot Cover

Make sure you keep the rubber cover provided in the ExpressCard slot when not in use. This will help prevent foreign objects and/or dust getting in to the Express-Card Slot.
Audio Features

You can configure the audio options on your computer from the Sound control panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar/control panel (right-click the taskbar icon to bring up an audio menu).
Hot Key Buttons

The hot key buttons on the top of the computer allow you to alter the brightness of the screen, and give instant access to a user-defined application, with one quick button press.

After installing the driver (see page 4 - 6) an icon will appear in the taskbar. Double-click the icon to bring up the configuration menu to define which application to open when the application hot key button is pressed (see over). If you click the close icon, run the program from the file location (C:\Program Files (x86)\Hotkey_Driver\HotkeyDriver.exe).

Brightness Hot Key
Repeatedly press the brightness hot key button to adjust the brightness. A visual indicator will appear on-screen to indicate the brightness level (as long as the hot key driver is running in the taskbar).
Features & Components

Application Hot Key
To configure a program to open when the application hot key button is pressed (Windows Media Player is the default program), follow the instructions below.

1. **Double-click** the Hot Key driver icon in the taskbar.
2. Click **Launch user specified application** (button).

![Launch user specified application dialog box]

3. **An Open** dialog box will appear on the screen.

![Open dialog box]

4. **Browse** to the directory where the desired application.exe program exists.
5. **Double-Click** on the program file or choose **Open**, and click **OK** (button).
6. Press the application hot key button to open the program (as long as the hot key driver is running in the taskbar).

---

Figure 2 - 8 Hot Key Driver

**Application.exe**
You will need to locate the actual application executable (.exe) file, not just the shortcut. To find the application right-click its shortcut on the desktop and click **Properties**. Click the **shortcut** (tab) and see where the executable file is located by clicking the **Open File Location** (button).
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it is always best to refer to the printer manual for specific instructions and configuration options.

**USB Printer**
Most current printers have a USB interface connection. You may use any one of the ports to connect the printer.

**Install Instructions:**
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. **Windows** will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

**Parallel Printer**
This is still a very common type of printer. The install instructions are in the sidebar, however you will need to purchase a Parallel to USB converter.

Parallel Printer
After setting up the printer attach the parallel cable to the printer.

Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.

Turn ON the printer, then turn ON the computer.

**Windows** will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Chapter 3: Power Management

Overview

To conserve power, your computer’s power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

- Turning on the Computer
- Power Plans
- System Power Options
- Configuring the Power Button

The computer uses enhanced power saving techniques to give the operating system (OS) direct control over the power and thermal states of devices and processors. For example, this enables the OS to set devices into low-power states based on user settings and information from applications.

Using some form of power management greatly increases the life span of the LCD.
Turning on the Computer

To the computer on simply press the power button on the top of the computer.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure this feature.

Note that if you have included the Hybrid TV Tuner in your purchase option, you may use the remote control unit to send the computer in to a power saving state.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep is the default power mode when the power button is pressed for less than 4 seconds. You may configure the options for the power button from the Power Options (Hardware and Sound menu) control panel in Windows Vista (see your OS’s documentation, or “Configuring the Power Button” on page 3 - 7 for details).
Power Plans

The computer can be configured to conserve power by means of power plans. You can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and to send the computer into Sleep after a period of inactivity.

Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.

Resuming Operation

If the display is off the system can resume by pressing any key on the keyboard.

Password

It is recommended that you enable a password on system resume in order to protect your data.

Figure 3 - 1
Power Plan Advanced Settings
Each *Windows power plan* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance.
System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. The system features **Sleep** and **Hibernate** power saving states.

Hibernate vs. Shut Down

Hibernate and Shut Down are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Sleep vs. Hibernate

If you want to stay away from your work for just a while, you can put the system into **Sleep** instead of in hibernation. It takes a longer time to wake up the system from **Hibernate** mode than from **Sleep** mode.
Power Management

Sleep
Sleep uses very little system power, and takes a short time to return to full operation. After an extended period of time in Sleep the computer will save the contents of system memory (e.g. any open documents and applications) to the hard disk and shut the system down. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Sleep mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the hard disk before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You will need to enable Hibernate mode from the Advanced Settings in power plans, or you put the system directly into Hibernate mode from the Lock Button Menu. The system will resume from Hibernate mode by pressing the power button.

Figure 3 - 3
Lock Button Menu
Hibernate

3 - 6 System Power Options
Configuring the Power Button

The power button may be set to send the computer into either Sleep or Hibernate. In Sleep, the LED will blink green. In Hibernate the LED will be orange. If only the display is turned off, the LED will remain green.

Password Protection

It is recommended that you enable a password on wake up in order to protect your data. However you can disable this setting from the Power Options menu by clicking Require a password on wakeup in the left menu, and selecting the options (click Change settings that are currently unavailable).
Power Management
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities.

RAID & AHCI Setup

Note that setting up the RAID system and installing the driver for Windows needs to be done prior to installing the Windows OS, and therefore before installing the other drivers listed here (see “Setting Up SATA RAID or AHCI Modes” on page 7 - 2).

What to Install

The Device Drivers & Utilities + User’s Manual CD-ROM (Win Vista OR WinXP) contains the drivers and utilities necessary for the proper operation of the computer. There will be two CDs provided; one will contain drivers for Windows Vista, the other will contain drivers for Windows XP (make sure you install the appropriate drivers for your system).

Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that the drivers are installed in the order indicated (see Appendix E for Windows XP information).
Drivers & Utilities

Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and click Install Drivers (button)/Optional (button).

If you wish to install the drivers manually see page 4 - 4.

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.

2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the Unlock button).

3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2
Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the driver (if it is not listed see below) and click Uninstall, and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as outlined in this chapter.

If the driver is not listed in the Programs and Features menu:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click Device Manager (Hardware and Sound > Device Manager).
3. Double-click the device you wish to update/reinstall the driver for (you may need to click “+” to expand the selection).
4. Click Driver (tab) and click the Update Driver or Uninstall button and follow the on screen prompts.

<table>
<thead>
<tr>
<th>Windows Vista Driver</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset (Included in Windows Vista OS)</td>
<td>N/A</td>
</tr>
<tr>
<td>Intel Video</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>NVIDIA Video</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 5</td>
</tr>
<tr>
<td>Modem</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>LAN (Included in Windows Vista OS)</td>
<td>N/A</td>
</tr>
<tr>
<td>Card Reader</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>JMicron</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Hot Key (for Brightness and Application Hot Keys)</td>
<td>Page 4 - 6</td>
</tr>
<tr>
<td>Intel Matrix (for RAID/AHCI)</td>
<td>Page 7 - 6</td>
</tr>
<tr>
<td>Wireless LAN Modules</td>
<td>Page 7 - 7</td>
</tr>
<tr>
<td>Bluetooth Module</td>
<td>Page 7 - 11</td>
</tr>
<tr>
<td>Remote Control Unit (for Remote Control Unit)</td>
<td>Page 7 - 13</td>
</tr>
<tr>
<td>Hybrid Mini-PCI TV Tuner Module</td>
<td>Page 7 - 16</td>
</tr>
<tr>
<td>PC Camera Module</td>
<td>Page 7 - 18</td>
</tr>
<tr>
<td>Wireless Keyboard &amp; Mouse Kit</td>
<td>Page 7 - 26</td>
</tr>
</tbody>
</table>

Table 4 - 1 - Driver Installation
Drivers & Utilities

Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer application, and then browse to the executable file in the location listed in the table below and follow the installation procedure for each driver. Note that X is the drive letter assigned to the CD/DVD-ROM drive.

<table>
<thead>
<tr>
<th>Driver</th>
<th>Driver Location</th>
<th>Driver</th>
<th>Driver Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chipset</td>
<td>N/A (Included in Windows Vista OS)</td>
<td>Intel Matrix (for RAID)</td>
<td>Vista 64-bit X:\Others\01Matrix\iata_cd.exe</td>
</tr>
<tr>
<td>Intel Video</td>
<td>Vista 64-bit X:\Drivers\01VGA\Intel\64bit\Setup.exe</td>
<td>WLAN Driver Installation (Intel)</td>
<td>Vista 64-bit X:\Others\02Wlan\Intel\ProDifX.exe</td>
</tr>
<tr>
<td>NVIDIA Video</td>
<td>Vista 64-bit X:\Drivers\01VGA\Nvidia\64bit\setup.exe</td>
<td>WLAN Driver Installation (AzureWave)</td>
<td>Vista 64-bit X:\Others\02Wlan\AzureW\setup.exe</td>
</tr>
<tr>
<td>Audio</td>
<td>Vista 64-bit X:\Drivers\02Audio\Setup.exe</td>
<td>Bluetooth Module</td>
<td>Vista 64-bit X:\Others\03Bluetooth\setup.exe</td>
</tr>
<tr>
<td>Modem</td>
<td>Vista 64-bit X:\Drivers\03Modem\setup.exe</td>
<td>Remote Control Unit (for TV Tuner)</td>
<td>Vista 64-bit X:\Others\04CIR\64bit\Setup.exe</td>
</tr>
<tr>
<td>LAN</td>
<td>N/A (Included in Windows Vista OS)</td>
<td>Hybrid Mini-PCI TV Tuner Module</td>
<td>* Note that the MPC788 Hybrid TV Tuner software is provided on a separate CD</td>
</tr>
<tr>
<td>Card Reader</td>
<td>Vista 64-bit X:\Drivers\05CReader\64bit\setup.exe</td>
<td>PC Camera Module</td>
<td>Vista 64-bit X:\Others\05Camera\64bit\setup.exe</td>
</tr>
<tr>
<td>JMicron</td>
<td>Vista 64-bit X:\Drivers\06Micron\setup.exe</td>
<td>Wireless Keyboard &amp; Mouse Kit</td>
<td>Vista 64-bit X:\Others\06WKit\SetupKey64.exe</td>
</tr>
<tr>
<td>Hot Key</td>
<td>Vista 64-bit X:\Drivers\07HotKey\Setup.exe</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4 - 2 - Driver Location

4 - 4 Driver Installation
User Account Control (Win Vista)
If a User Account Control prompt appears as part of the driver installation procedure, click Continue or Allow, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of the driver installation process. Just click “Install this driver software anyway” or Install to continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure as directed.

Chipset
This driver is included in the Windows Vista OS and therefore does not need to be installed from the CD.

Intel Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video
1. Click 2.Install Video Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

Audio
1. Click 3.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
Drivers & Utilities

Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
This driver is included in the Windows Vista OS and therefore does not need to be installed from the CD.

Card Reader
2. Click Next.
3. Click the button to accept the license, and then click Next.
4. Click Finish.

JMicron
1. Click 7.Install JMicro Driver > Yes.
2. Click Next > Install.
3. Click Finish to restart the computer.

Hot Key
1. Click 8.HotKey Driver > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart your computer.
Module Drivers
See the pages indicated for the driver installation procedures for any optional modules included in your purchase option.

RAID & AHCI
See the setup procedure for your RAID module in “Setting Up SATA RAID or AHCI Modes” on page 7-2, and driver installation procedure in “Intel Matrix” on page 7-6.

Wireless LAN
See the install procedure for your WLAN module in “Wireless LAN Modules” on page 7-7.

PC Camera
See the install procedure in “PC Camera Module” on page 7-18.

Bluetooth
See the install procedure in “Bluetooth Module” on page 7-11.

Remote Control Unit
See the install procedure for the consumer infrared driver in “Remote Control Unit” on page 7-13.

TV Tuner
The drivers and utilities for the optional TV Tuner are provided on a separate CD. Some general guidelines are outlined in “Hybrid Mini-PCI TV Tuner Module” on page 7-15.

Wireless Kit
See the install procedure for the wireless kit driver in “Wireless Keyboard & Mouse Kit” on page 7-23.
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.

Incorrect settings can cause your system to malfunction. To correct mistakes, return to Setup and restore the Setup Defaults with <F9>.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.

Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.
Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

- Press <F1> to resume
- <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, and then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., 00 = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.

Installed Memory/Available to OS/Used by devices (Main Menu)
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.
Advanced Menu

Chipset Information Menu (Advanced Menu)
This menu provides information on the BIOS version and CPU type.
**Reset Configuration Data: (Advanced Menu)**
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

**Legacy USB Support: (Advanced Menu)**
Choose “Enabled” if you intend to use USB devices in systems which do not normally support USB functionality (e.g. DOS). The default setting is “Enabled” and does not need to be changed if you intend to use your USB devices in Windows.

**Boot-time Diagnostic Screen: (Advanced Menu)**
Use this menu item to enable/disable the Boot-time Diagnostic Screen (or POST screen).

**Energy Lake: (Advanced Menu)**
Energy Lake is a special sleep mode system which allows your system to Quick Resume when you use a remote control unit.
**IGD Memory Size (Advanced Menu > Advanced Chipset Control)**
Press **Enter** here to select the amount of pre-allocated graphics memory for the integrated graphics device (Intel Video option only). The default setting is **256MB**.

**SATA RAID Enable: (Advanced Menu)**
This menu item allows you to **enable/disable** SATA RAID for your hard disks. **You should only enable/disable this item BEFORE installing an operating system**, and after you have backed up all necessary files and data (see sidebar).

**SATA AHCI Enable: (Advanced Menu)**
This menu item allows you to **enable/disable** SATA RAID for your hard disks. **You should only enable/disable this item BEFORE installing an operating system**, and after you have backed up all necessary files and data (see sidebar).
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see over).
**Fixed disk boot sector:** *(Security Menu)*

Choose **Write Protect** to protect the area of the hard disk containing information on how to start up the computer from having information written to it. This helps prevent viruses from affecting this area, however, it is not a substitute for proper virus protection supplied by updated anti-virus software, merely an extra safeguard (see “Viruses” on page 8 - 4).

**Password on boot:** *(Security Menu)*

Specify whether or not a password should be entered to boot the computer. If “**Enabled**” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “**Disabled**”.

**Note:** To clear existing passwords press **Enter** and type the existing password, then press **Enter** for the new password (without typing any password entry) and **Enter** again to confirm the password clearance.

---

**Password Warning**

If you set a boot password (Password on boot is “Enabled”), **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
When you turn the computer on it will look for an operating system (e.g. WindowsXP) from the devices listed in this menu, and **in this priority order**. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the **Boot priority order**. Item specific help on the right is available to help you move devices up and down the order.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Set-up** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components.

The chapter includes:

- Upgrading the Hard Disk Drive(s)
- Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.
Upgrading The Computer

When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

---

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines).

---

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Upgrading the Hard Disk Drive(s)

The hard disk drive(s) can be taken out to accommodate other 3.5" serial (SATA) hard disk drives with a height of 26mm (h) (see “Storage” on page D - 3).

1. Turn the computer off and disconnect all peripherals and cables (including telephone lines).
2. Place the computer on a flat stable surface, preferably on a protective covering to avoid damage to the LCD screen.
3. Locate the hard disk bay cover and remove screw 1/2, depending on which hard disk you want to replace.
4. Remove the hard disk cover(s) by sliding it(them) in the direction of arrow 3.

**Warning**
New HDD’s are blank. Before you begin make sure:
- You have backed up any data you want to keep from your old HDD.
- You have all the CD-ROMs and FDDs required to install your operating system and programs.
- If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.

![Figure 6 - 1]
Hard Disk Bay & Screws
Upgrading The Computer

5. Remove the hard disk cover(s) ④.
6. Remove the hard disk screws ⑤ - ⑧ from the hard disk(s) you want to replace.

Figure 6 - 2
HDD Cover
Removal & Screws

6 - 4 Upgrading the Hard Disk Drive(s)
7. Carefully disconnect cable(s) from the hard disk(s) you want to replace.
8. Remove the hard disk screws and brackets.
9. Reverse the process to install any new hard disk.
10. If you are configuring the hard disks in AHCI mode or as a RAID system see “Setting Up SATA RAID or AHCI Modes” on page 7-2.

Figure 6-3
HDD Cable(s) & Bracket Removal
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) DDRII (DDR2) 533/667 type memory modules (see “Memory” on page D-2 for details of supported module types).

1. Turn the computer off and disconnect all peripherals and cables (including telephone lines).
2. Place the computer on a flat stable surface, preferably on a protective covering to avoid damage to the LCD screen.
3. Remove screws 1 & 2.

*Figure 6-4 Component Cover Screws*
4. Carefully (a fan and cable are attached to the under side of the cover) slide the component cover in the direction of arrow 3, until the arrow 4 aligns with the unlock symbol.
5. Carefully disconnect the fan cable 5 from point 6 on the mainboard.
6. Remove the component cover 7 and locate the memory socket 8.
Upgrading The Computer

7. Gently pull the two release latches on the sides of the memory socket in the direction indicated by the arrows (9 & 10).

8. The RAM module will pop-up, and you can remove it.
9. Pull the latches to release the second module if necessary.
10. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.
11. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.
12. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.

6 - 8 Upgrading the System Memory (RAM)
13. Replace the component cover (don’t forget to reconnect the fan cable) and the screws.
14. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.

Figure 6 - 7
RAM Module Removal
Upgrading The Computer

Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.

Unauthorized tampering with the HDD may also violate your warranty.
Chapter 7: Modules

Overview

This chapter contains the information on the various modules (some of which are optional) which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

- Setting Up SATA RAID or AHCI Modes
- Wireless LAN Modules
- Bluetooth Module
- Remote Control Unit & Hybrid Mini-PCI TV Tuner Module
- PC Camera Module
- Wireless Keyboard & Mouse Kit
RAID

If your purchase includes the RAID (Redundant Array of Independent Disks) option, the following pages provide an introduction to configuring your hard disks in RAID mode. A RAID requires two hard disks, and you may use your hard disks in combination with Striping (RAID 0) or Mirroring (RAID 1) for either fault tolerance or performance.

AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows the storage driver to enable advanced Serial ATA features such as Native Command Queuing (for maximum hard disk efficiency and performance). AHCI mode can be supported by one or two hard disks.

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to increase performance. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to protect data. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
</tbody>
</table>
Prepare the following before setting up your Serial ATA hard disks in RAID or AHCI mode:

1. The Microsoft Windows Vista OS CD.
2. The second hard disk (required for RAID but not required for AHCI) installed in the optional device drive bay (see page 6 - 3).

SATA RAID or AHCI Setup Procedure (BIOS)
3. Start-up your computer and press <F2> to enter the BIOS.
4. Go to the Advanced menu.
   • For RAID Mode: - Set "SATA RAID Enable" ("SATA RAID Enable: (Advanced Menu)" on page 5 - 9) to "Enabled".
   OR
   • For AHCI Mode: - Set "SATA AHCI Enable" ("SATA AHCI Enable: (Advanced Menu)" on page 5 - 9) to "Enabled".
5. Press Esc and go to the Boot menu.
6. Set the external CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first device in the boot order from the Boot menu.
7. Attach the external USB floppy disk drive to one of the computer’s USB ports.
8. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.
For RAID Only (for AHCI Mode go to “Intel Matrix” on page 7 - 6)

1. Press Ctrl + i to enter RAID configuration menu.


3. Specify the **RAID volume name** and then press Tab or Enter to advance to the next field.

4. Specify the **RAID level** (RAID 0 or RAID 1 - see Table 7 - 1, on page 7 - 2 and sidebar) and then press Tab or Enter to advance to the next field.

5. Press Enter and the system will select the physical disks to use.

6. Press Enter and select (if applicable) the Strip Size (best set to default).

7. Press Enter and select the Capacity size (best set to default).

8. Press Enter to **Create Volume**.

**Array Types**

A **Mirrored Array** (RAID 1) provides full data protection, as data can simply be copied from a healthy disk to a replacement for any failed disk.

A **Striped Array** (RAID 0) is NOT fault-tolerant. The failure of one drive will result in the loss of all data in the array. It is designed to increase disk performance by spreading the I/O load across the channels and drives.

*Figure 7 - 1
Intel(R) Matrix Storage Manager*
9. Confirm the selection by pressing Y.
10. This will now return to the main menu.

11. Select 4. Exit and press Enter, then press Y to exit the RAID configuration menu.
12. As the computer starts up, press a key when you see the message "Press any key to boot from CD".
13. Press Enter to continue installing the operating system as normal (see your Windows documentation if you need help on installing the Windows OS).
14. Install the Windows drivers as per Table 4 - 1, on page 4 - 3, including the Intel Matrix Driver (see overleaf)
1. Insert the *Device Drivers & Utilities + User’s Manual CD-ROM (Win Vista)* into the CD/DVD drive.
2. Click **Optional**.
3. Click **1. Install Intel Matrix > Yes**.
4. Click **Next > Next > Yes > Next**.
5. Click **Finish** to restart the computer.
6. The **Intel Matrix Storage Console** displays status information on your RAID configuration.
7. Run **Intel Matrix Storage Console** from the Programs/All Programs menu.
8. The **Intel(R) Matrix Storage Manager** provides information on the RAID status.

*Figure 7-3*

*Intel(R) Matrix Storage Console*
Wireless LAN Modules

If you have included either an Intel PRO/Wireless 3945ABG (802.11a/b/g) PCIe WLAN module, or 802.11b/g USB WLAN module, in your purchase option the LED will be green. Install the driver as indicated below.

WLAN Driver Installation
2. Click Optional.
3. Click 2.Wireless Lan > Yes.
4. Click Finish to complete the installation.
5. The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
Connecting to a Wireless Network

1. Click the taskbar wireless icon and then click Connect to a network (or right-click the icon and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.

3. A list of currently available networks will appear.
4. Click a network, and then click **Connect**.
5. If you do not see a network you want to connect to, click **Set up a connection or network** (a list of options will appear allowing manual searching, and creating a new network).

6. Move the cursor over the taskbar icon to see the connection status (see below).
7. To disconnect from the wireless network you can click the taskbar wireless icon, and then select **Connect or disconnect** to access the network menu, and click **Disconnect** (or right-click the icon, and then click **Disconnect from**).

Security Enabled Networks

You should try to make sure that any network you are connecting to is a secure network.

Connecting to unsecure networks may allow unauthorized access to your computer, documents, websites and files etc.

*Figure 7 - 8*

Disconnecting

7 - 10 Wireless LAN Modules
Bluetooth Module

If you have included a Bluetooth module in your purchase option the LED will be orange.

Bluetooth Driver Installation

2. Click Optional.
3. Click 3.Install Bluetooth Driver > Yes.
4. Choose the language you prefer, and click OK.
5. Click Next.
6. Click the button to accept the license agreement, and then click Next.
7. Click Next > Install.
8. Click Finish, and the BlueSoleil icon will appear on the desktop.
9. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Window (Start > Programs/All Programs > IVT BlueSoleil > BlueSoleil), or by clicking the desktop icon.

User Guides & Help

View the BlueSoleil User Guides from the Help Menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel.

Click the Help menu and select Contents and Index.

Look through Getting Started or select the appropriate User Guide from the Contents menu.

Figure 7 - 9
BlueSoleil Main Window & Help
Remote Control Unit

If your purchase includes the optional TV Tuner module you will be provided with a remote control unit. You need to install the consumer infrared driver to enable all the remote control unit functions.

The remote control unit allows you to remotely start and send the system into a power saving state, to run Windows Media Center and to navigate the Media Center menus etc. The remote control unit also gives full control over all TV and video functions.

Consumer Infrared Driver Installation

2. Click Optional.
3. Click 4.Install ITE CIR > Yes.
4. Click Next > Yes > Next.
5. Click Finish.
1. Sleep Button (Sends the system into the sleep mode [Sleep or Hibernate] as configured by the Sleep Button - see sidebar).
2. My TV
3. My Music
4. My Pictures
5. My Videos
6. Stop
7. Record
8. Pause
9. Play
10. Rewind
11. Fast Forward
12. Replay
13. Skip
14. Back
15. More (Information)
16. Cursor Keys & OK (Used to Navigate Media Center Menus)
17. Volume
18. Channel Change
19. Start (Starts Windows Media Center)
20. Mute
21. Recorded TV
22. Guide
23. Live TV
24. DVD Menu
25. Number Pad
26. Clear
27. Enter

Sleep Button
You can configure the sleep button action (when I press the sleep button) from the power options control panel (see “Configuring the Power Button” on page 3 - 7).
Hybrid Mini-PCI TV Tuner Module

A CD containing drivers, software and a user guide will be supplied if your purchase configuration includes the optional Hybrid (Analog & Digital) Mini-PCI TV Tuner module.

The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The two CATV antenna jacks and S-Video-In jack will only be enabled when the TV Tuner module is installed. Make sure you install any software before connecting the TV antenna.

1. Consumer IR Transceiver
2. S-Video-In Jack
3. 2 * CATV-In (Coaxial) Jacks

(Note: You can use one of the CATV-In jacks to connect a CATV cable, and the other to connect a Digital Aerial.)
MPC788/MPC718 Driver & Software
1. Insert the driver *MPC788 or MPC718 CD-ROM* into the CD/DVD drive.
2. Follow the on screen instructions to install the driver software.
3. The TV Tuner is fully supported by *Windows Media Center* in *Windows Vista (Home Premium Edition & Ultimate Edition)*.
4. Run *Windows Media Center* directly from the Start menu (Start > Programs > Windows Media Center).
5. *Windows Help and Support* provides information on the *Windows Media Center* functions. Click Start and select Help and Support, and then type “Media Center” in the Search Help box and click the magnifying glass icon to bring up the results.

TV Antenna Support
The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.

Note that the TV Tuner module (factory) options in *Windows Vista* are supported by the *Windows Media Center* software which comes built-in to the *Windows Vista Home Premium* and *Ultimate Editions* only.

If your purchase includes a TV Tuner option, and you are re-configuring your system for a different system, you should install either *Windows Home Premium or Ultimate Editions* only.
Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV broadcast signal. The **passive** antenna provided should provide a clear signal when placed beside a window. If the signal is not clear then you can purchase an **active** antenna (it should also be placed beside a window) to improve the signal. You should also check with any related government website which provides information on digital terrestrial TV coverage for your area. Note that (unlike standard analog TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Schemes
If you intend to use the **optional** TV Tuner to record live TV, then go to the **Power Options** control panel and create a power plan (see “Power Plans” on page 3 - 3) to prevent the power saving options from adjusting the computer’s performance level.
PC Camera Module

If you have included a PC Camera module in your purchase option, install the driver as indicated below.

PC Camera Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual CD-ROM (Win Vista)* into the CD/DVD drive.
2. Click *Optional*.
3. Click *5. PC Camera, Web cam > Yes*.
4. Choose the language you prefer and click *Next*.
5. Click *Install*.
6. Click *Finish* to restart the computer.
7. Run the *BisonCap* program from the *BisonCam* item in the *Start > Programs/All Programs* menu.

Latest PC Camera Driver Information

Check the *PC Camera CD*, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
**PC Camera Audio Setup**

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in *Windows* (see *Figure 7 - 12 on page 7 - 20*).

1. Click **Start**, and click **Control Panel** (or point to **Settings** and click **Control Panel**).
2. Click **Sound** *(Hardware and Sound)*.
3. Click **Recording** (tab).
4. Right-click **Microphone** *(Realtek High Definition Audio)* and make sure the item is not disabled.
5. Double-click **Microphone** (or select **Properties** from the right-click menu).
6. Click **Levels** (tab), and adjust the **Microphone** and **Microphone Boost** sliders to the level required.
7. Click **OK** and close the control panels.
8. Run the **BisonCap** application program from the **Start > Programs/All Programs > BisonCam** menu.
9. Go to the **Devices** menu heading and select **Microphone** *(Realtek)*... (it should have a tick alongside it).
10. Go to the **Capture** menu heading and select **Capture Audio** (it should have a tick alongside it).
Modules

Figure 7 - 12
Audio Setup for PC Camera

Right-click

7 - 20 PC Camera Module
BisonCam

BisonCam is a video viewer useful for general purpose video viewing and testing, and can capture video files in .avi format.

1. Run the BisonCam program from the Start > Programs/All Programs > Bison-Cam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 19) and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (see the sidebar - Pre-Allocating File Space) for the captured file.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, then click Open (you can view the file using the Windows Media Player).

Set Capture File
You will only be asked to set the capture file name on the first run of the BisonCam program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).
Eliminating Screen Flicker

If you find that the video screen in the BisonCam program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCam program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 13
Video Capture Filter
Wireless Keyboard & Mouse Kit

If you have included the RF wireless keyboard and mouse kit in your purchase option, a quick installation guide is provided to guide you through setting up the system. However, first setup the hardware as per the instructions overleaf.

Figure 7 - 14
Wireless Keyboard & Mouse Kit
1. Wireless RF Keyboard
2. USB Dongle Receiver
3. Wireless RF Mouse
Wireless Kit Hardware Setup

1. Turn the computer off and disconnect all peripherals and cables (including telephone lines).
2. Place the computer on a flat stable surface, preferably on a protective covering to avoid damage to the LCD screen.
3. Locate the USB port cover 1 and remove the screw and cover.
4. Insert the USB Dongle receiver 2 into the USB port.

Figure 7 - 15
Inserting the USB Receiver Dongle
5. Make sure all the appropriate batteries are correctly inserted into the mouse and keyboard.
6. Make sure the mouse is powered on (the power switch is on the base of the mouse).
7. Follow the instructions in the *Quick Installation Guide* to conduct the **ID Pairing Procedure**.
8. Install the driver Wireless Kit driver (see “Wireless Kit Driver” on page 7 - 26).
9. Once you have confirmed that the keyboard and mouse are functioning correctly you can replace the USB port cover and screw (see *Figure 7 - 15 on page 7 - 24*).
Wireless Kit Driver
1. Insert the *Device Drivers & Utilities + User’s Manual CD-ROM (Win Vista)* into the CD/DVD drive.
2. Click **Optional**.
3. Click **6. Install WKit Driver > Yes**.
4. Click the button to install the driver.
5. Click **OK**.
6. Double-click the taskbar icon (or right-click the icon and select **Configure**) to access the control panel.
7. A full **Help** menu is available from the control panel.

**Figure 7 - 16**  
KeyMaestro Control Panel
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power Indicator (see “LED Indicators” on page 1 - 12) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options (see “Configuring the Power Button” on page 3 - 7/“Configuring the Power Button” on page E - 20), the sleep key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the brightness hot key.

- **Boot Drive** - Make sure there are no optical media and/or USB storage devices in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

- Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

- Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

- Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Supervisor** password for the BIOS (see “Security Menu” on page 5 - 10).

- Keep copies of vital **settings files** such as network, dialup settings, mail settings etc.(even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Troubleshooting

Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Upgrading and Adding New Hardware/Software

• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

- Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

- Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
# Problems and Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels too hot.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1-15). Make sure you’re using the correct adapter.</td>
</tr>
</tbody>
</table>
| Nothing appears on screen.     | *The system is in a power saving mode.* Toggle the sleep/resume key combination set in Power Options (see “Configuring the Power Button” on page 3-7/“Configuring the Power Button” on page E-20).  
*The screen saver is activated.* Press any key or move the mouse.                                                                                           |
| You forget the boot password.  | If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.                                 |

## Password Warning

If you choose to set a boot password, **NEVER** forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The sound cannot be heard or the volume is very low.</td>
<td><em>The volume might be set too low.</em> Check the volume control in the <strong>Volume Control Panel</strong> in the Windows taskbar (see “Audio Features” on page 2 - 8/“Audio Features” on page E - 4) to adjust.</td>
</tr>
<tr>
<td>The compact disc cannot be read.</td>
<td><em>The compact disc is dirty.</em> Clean it with a CD-ROM cleaner kit.</td>
</tr>
<tr>
<td>The compact disc tray will not open when there is a disc in the tray.</td>
<td><em>The compact disc is not correctly placed in the tray.</em> Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2 - 3).</td>
</tr>
<tr>
<td>The DVD regional codes can no longer be changed.</td>
<td><em>The code has been changed the maximum 5 times.</em> See “DVD Regional Codes” on page 2 - 5/“DVD Regional Codes” on page E - 2.</td>
</tr>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out.</em> Press the sleep key combination, or press the power button if no LEDs are lit.</td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td>Power Options features are not enabled. Go to the <strong>Windows</strong> Power Options menu and enable the features you prefer (see “System Power Options” on page 3 - 5/“System Power Options” on page E - 18). Make sure you have enabled Hibernate mode from the control panel.</td>
</tr>
</tbody>
</table>
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
## Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card Reader Port</td>
<td>The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>E-SATA Port</td>
<td>Plug external Serial ATA hard drives into this port.</td>
</tr>
<tr>
<td>Headphone-Out Jack (Green)</td>
<td>Headphones or speakers may be connected through this jack. <strong>Note:</strong> Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
<tr>
<td>Line-In Jack (Blue)</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers.</td>
</tr>
<tr>
<td>Microphone-In Jack (Pink)</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
</tbody>
</table>
### Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ-11 Phone Jack</td>
<td>This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection. Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>Mini-IEEE 1394 Port</td>
<td>This port allows a high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Mini-IEEE 1394 Port" /></td>
</tr>
<tr>
<td></td>
<td>Mini-IEEE 1394 Port&lt;br&gt;The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.</td>
</tr>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions. Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
<tr>
<td>S/PDIF-Out Jack</td>
<td>This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device). The system includes a USB port under the top rear cover (2 in <em>Figure 1 - 7 on page 1 - 15</em>). This port is designed for use with the optional RF keyboard receiver dongle, but may also be used with any USB Device.</td>
</tr>
</tbody>
</table>
## Audio/Video Jacks

*Figure A - 1 - Audio/Video Jacks*

<table>
<thead>
<tr>
<th>Port/Jack</th>
<th>Connection</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 S-Video-In Jack</td>
<td>Connect an <strong>S-Video</strong> Cable to this Jack to Display External Video Sources on the LCD</td>
</tr>
<tr>
<td>2 Right &amp; Left Audio-In Jacks</td>
<td>Connect <strong>Analog Audio</strong> Cables to Play External Audio Sources Through the Computer’s Speakers</td>
</tr>
<tr>
<td>3 Composite Video-In Jack</td>
<td>Connect a <strong>Composite Video</strong> Cable to this Jack to Display External Video Sources on the LCD</td>
</tr>
</tbody>
</table>
| 4 CATV-In (Coaxial) Jacks (for **TV Tuner** Option Only) | Connect a **CATV Cable or Digital Aerial** to Display Cable TV Pictures on the LCD  
(Note: You can use one of the CATV-In jacks to connect a CATV cable, and the other to connect a Digital Aerial.) |

*Figure A - 2 - Audio/Video Jack Connections*

**CATV Cable Safety**

Make sure that your CATV system installer has connected the coaxial cable shield to the grounding system of the building, as close to the point of cable entry as practical.
Interface (Ports & Jacks)
Appendix B: Intel Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 18.

Video Driver Installation
To access the Intel Graphics Media Accelerator Driver Controls you must install the video driver as indicated below). Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Intel Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Dynamic Video Memory Technology
This system features Intel® Dynamic Video Memory Technology. Intel® DVMT automatically and dynamically allocates as much (up to 376MB) system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system. You can define the amount of system memory to be allocated from the BIOS (see “” on page 5 - 8).
More advanced video configuration options are provided by the Intel(R) Graphics Media Accelerator Driver control panel.

1. Open the Display Settings control panel (see “Video Features” on page 1-15) and click Advanced Settings (button).
2. Click the Intel(R) Graphics Media Accelerator Driver tab and click Graphics Properties (button).

Taskbar Icon

The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

If you cannot see the tray icon click the “Show Tray Icon” tickbox in the Intel(R) Graphics Media Accelerator Driver tab.

Figure B - 1
Intel Graphics Properties
You may make changes to the color, schemes, **Hot Keys** etc. by clicking the appropriate menu item or button. Click **Information** (button) to obtain useful information about the graphics properties of the computer, and see the **Support** tab in **Information** to get weblinks to the latest information on the Intel Website.

Right-click on many of the items in the tabs to bring up the “What’s This?” button.

Click the “What’s This?” button to bring up the help menu.

**Figure B - 2**
Intel Graphics Media Accelerator Driver (Control Panel Tabs)
Scheme Options

Use Scheme Options to configure quick settings for applications which require specific resolution and color settings in order to run properly e.g. games, multimedia programs. To set the scheme options:

1. Open the Display Settings control panel and click Advanced Settings (button).
2. Click the Intel(R)... tab and click Graphics Properties (button).
3. Configure your display configuration, resolution etc. as per your requirements from Display Settings.
4. Click on Scheme Options (button).
5. Type a name for the scheme (then click Save or see below).
6. If you want to automatically launch an application when running the scheme click on Browse (button).
7. Browse to the executable file for the application you want to set the scheme for (see sidebar), and click Open to select it.
8. Click Save to save the settings (you can click in the "Restore the display settings after exiting this application" box to return to your original settings when you exit the program).
9. Click OK to exit the window.
10. You can run the scheme by clicking the taskbar icon and selecting the scheme from Select Scheme.

Application.exe

You will need to locate the actual application executable (.exe) file, not just the shortcut. To find the application right-click its shortcut on the desktop click Properties. Click the Shortcut (tab) and see where the executable file is located by clicking the Open File Location (button). Note the location and you will then be able to browse to this file.

Figure B - 3
Select Scheme
Appendix C: NVIDIA Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 18.

Video Driver Installation

To access the NVIDIA GeForce Go controls you must install the video driver as indicated below. Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

**NVIDIA Video**

1. Click **2. Install Video Driver > Yes.**
2. Click **Next.**
3. Click **Finish** to restart the computer.
More advanced video configuration options are provided in the NVIDIA Control Panel tab.

1. Open the Display Settings (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce Go 7600 (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the menu if you are in Control Panel Home).

Figure C - 1
NVIDIA GeForce Go Control Panel
The NVIDIA Control Panel allows quick access to features such as 3D Settings and Help menus etc.

Navigating the Control Panel

Navigate through the control panels in much the same way as you would a web page. Click on the headings, menus and highlighted links for information. Use the buttons on the top left to go back, forward etc.

Figure C - 2
NVIDIA Control Panels
The **Help** menus provide index and search features, and direct links to the NVIDIA website etc.

*Figure C - 3*

**Help Menus**
The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed or updated due to the manufacturer’s release schedule. Check with your service center for details.
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor</strong></td>
<td>Intel® Core™ 2 Duo Desktop Processor LGA775 Package (775-pin) E6300/ E6400</td>
</tr>
<tr>
<td></td>
<td>65nm (65 Nanometer) Process Technology 2MB On-die L2 Cache &amp; 1066MHz FSB 1.86/ 2.13 GHz</td>
</tr>
<tr>
<td></td>
<td>Intel® Core™ 2 Duo Desktop Processor LGA775 Package (775-pin) E6600/ E6700</td>
</tr>
<tr>
<td></td>
<td>65nm (65 Nanometer) Process Technology 4MB On-die L2 Cache &amp; 1066MHz FSB 2.40/ 2.67 GHz</td>
</tr>
<tr>
<td><strong>Core Logic</strong></td>
<td>Intel G965 +ICH8-DH Chipset</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>64-bit Wide DDR2 Data Channel</td>
</tr>
<tr>
<td></td>
<td>Two 200 Pin SO-DIMM Sockets Supporting DDR2 533 / 667 MHz</td>
</tr>
<tr>
<td></td>
<td>Memory Expandable up to 4GB (256/ 512/ 1024/ 2048 MB DDR2 Modules)</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Security (Kensington® Type) Lock Slot BIOS Password</td>
</tr>
<tr>
<td><strong>BIOS</strong></td>
<td>One 1024KB Flash ROM Phoenix™ BIOS, Plug and Play</td>
</tr>
<tr>
<td><strong>LCD</strong></td>
<td><strong>Model A Computers</strong></td>
</tr>
<tr>
<td></td>
<td>19&quot; Wide Screen WXGA+ (1440*900)</td>
</tr>
<tr>
<td></td>
<td>16:10 Wide Screen Flat Panel TFT</td>
</tr>
<tr>
<td></td>
<td><strong>Model B Computers</strong></td>
</tr>
<tr>
<td></td>
<td>22&quot; Wide Screen WSXGA+ (1680*1050)</td>
</tr>
<tr>
<td></td>
<td>16:10 Wide Screen Flat Panel TFT</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Integrated Video Option</th>
<th>Discrete Video Option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video Adapter Options</strong></td>
<td>Intel G965 Integrated Video</td>
<td>NVIDIA GF-GO7600-N-B1 (w/o HDMI)</td>
</tr>
<tr>
<td></td>
<td>Shared Memory Architecture of up to 376MB of Dynamically Allocated Video Memory</td>
<td>PCI-E MXM II Video Card</td>
</tr>
<tr>
<td></td>
<td>Fully Supports DirectX 9.0</td>
<td>256MB DDR2 Video RAM on Board</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PCI-Express X16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fully Supports DirectX 9.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MXM Modular Design</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page D - 5 for drive options)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Two Changeable Bays for 3.5” 26mm (h) Serial-ATA (SATA) Hard Disk Drives</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports RAID 0, RAID 1, HDD Fault Tolerance System in SATA Configuration</td>
<td></td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>Supports 7.1 CH Audio Output Via S/PDIF Port</td>
<td>S/PDIF Output</td>
</tr>
<tr>
<td></td>
<td>Integrated AZALIA Compliant Interface (HDA)</td>
<td>2 * Built-In 3W Speakers</td>
</tr>
<tr>
<td></td>
<td>3D Stereo Enhanced Sound System</td>
<td>Built-In 6W Sub Woofer</td>
</tr>
<tr>
<td></td>
<td>Sound-Blaster PRO™ Compatible</td>
<td>Built-In Microphone</td>
</tr>
<tr>
<td><strong>Keyboard &amp; Pointing Device</strong></td>
<td>RF Winkey Keyboard (Option)</td>
<td>USB I/F Receiver Dongle (Option)</td>
</tr>
<tr>
<td></td>
<td>RF Mouse (Option)</td>
<td></td>
</tr>
<tr>
<td><strong>ExpressCard Slot</strong></td>
<td>ExpressCard/34/54 Slot</td>
<td></td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interface</strong></td>
<td>Four USB 2.0 Ports&lt;br&gt;One USB 2.0 Port (for RF KB &amp; Mouse)&lt;br&gt;One E-SATA Port&lt;br&gt;One Mini-IEEE1394 Port&lt;br&gt;One Headphone-Out Jack&lt;br&gt;One Microphone-In Jack&lt;br&gt;One Line-In Jack&lt;br&gt;One S/PDIF Output Jack (5.1CH)&lt;br&gt;One S-Video-In Jack&lt;br&gt;Two CATV-In Jacks (for TV Tuner Cards)&lt;br&gt;One RJ-11 Jack for Plug &amp; Play Fax/Modem&lt;br&gt;One RJ-45 Jack for 10Mb/ 100Mb/ 1000Mb Fast Ethernet&lt;br&gt;One DC-in Jack&lt;br&gt;One Brightness Button&lt;br&gt;One Power Switch&lt;br&gt;One A.P. Key (For Fan Control)&lt;br&gt;One CIR Port (Optional for TV Tuner)</td>
</tr>
<tr>
<td><strong>Card Reader</strong></td>
<td>Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)&lt;br&gt;&lt;strong&gt;Note:&lt;/strong&gt; MS Duo/ Mini SD/ RS MMC Cards Require a PC Adapter</td>
</tr>
<tr>
<td><strong>Communication</strong></td>
<td>AZALIA MDC 56K Plug &amp; Play Fax/Modem v.90/92 Compliant&lt;br&gt;1GB PCI Fast Ethernet&lt;br&gt;Intel PRO/Wireless 3945ABG PCIe Wireless LAN Module (Option)&lt;br&gt;USB 2.0 Bluetooth + EDR (Enhanced Data Rate) Module - Version 2.0 (Factory Option)&lt;br&gt;1.3M PC Camera with USB Interface (Factory Option)&lt;br&gt;11 Hot Keys for Internet &amp; Multimedia via RF KB (Factory Option)</td>
</tr>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 2.0&lt;br&gt;Power Button as Sleep/Resume Key&lt;br&gt;Supports Hibernate Mode&lt;br&gt;Supports Sleep/Stand by Mode&lt;br&gt;Supports Resume from Modem Ring&lt;br&gt;Supports Resume from Alarm</td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power</strong></td>
<td>Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz / DC Output 20V, 9.0A (180 Watts)</td>
</tr>
<tr>
<td><strong>Environmental Spec</strong></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating: 5°C ~ 35°C</td>
<td>Non-Operating: -20°C ~ 60°C</td>
</tr>
<tr>
<td>Relative Humidity</td>
<td></td>
</tr>
<tr>
<td>Operating: 20% ~ 80%</td>
<td>Non-Operating: 10% ~ 90%</td>
</tr>
<tr>
<td>**Physical Dimensions &amp; Weight</td>
<td>625.5mm (w) * 396.9mm (d) * 110mm (h) including hinge assembly 11kg Approximately</td>
</tr>
<tr>
<td><strong>Optional</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Optical Drive Module Options:</strong></td>
<td>1.3M PC Camera with USB Interface (Factory Option)</td>
</tr>
<tr>
<td>DVD/CD-RW Combo Drive Module</td>
<td>USB 2.0 Bluetooth + EDR (Enhanced Data Rate) Module - Version 2.0 (Factory Option)</td>
</tr>
<tr>
<td>DVD Super Multi Drive Module</td>
<td>802.11b/g USB (Mini Card) Wireless LAN Module</td>
</tr>
<tr>
<td>USB Floppy Disk Drive Module</td>
<td>2nd SATA RAID Hard Disk Drive</td>
</tr>
<tr>
<td>Intel PRO/Wireless 3945ABG PCIe Wireless LAN Module</td>
<td></td>
</tr>
<tr>
<td>Hybrid TV Tuner Card Module</td>
<td></td>
</tr>
<tr>
<td>with Remote Control Unit</td>
<td></td>
</tr>
<tr>
<td>RF Keyboard &amp; RF Mouse with USB Receiver</td>
<td></td>
</tr>
</tbody>
</table>
Appendix E: Windows XP Information

This Appendix contains information (including control panel information, driver installation etc.) for users of the Windows XP OS.
Windows XP Information

DVD Regional Codes

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

*Table E - 1 - DVD Region Codes*
Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within *Windows XP* (and most other *Windows* versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in *Windows* (e.g. power, video, network, audio etc.). *Windows XP* provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all controls it may be necessary to toggle off Category View.
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices in Windows control panel. For advanced options double-click the Realtek HD Audio Manager icon in the taskbar (or click the control panel) to bring up the Realtek Audio Configuration menus.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows (and the volume control function keys on the computer). Click the Volume icon on the taskbar to check the setting.

Figure E - 3
Realtek Audio Configuration Menus
Hot Key Buttons

The hot key buttons on the top of the computer allow you to alter the brightness of the screen, and give instant access to a user-defined application, with one quick button press.

After installing the driver (see page E - 27) an icon will appear in the taskbar. Double-click the icon to bring up the configuration menu to define which application to open when the application hot key button is pressed (see over). If you click the close icon, run the program again from the Start menu in Windows (Start > Programs/All Programs > Startup > HotKey Driver).

Brightness Hot Key
Repeatedly press the brightness hot key button to adjust the brightness. A visual indicator will appear on-screen to indicate the brightness level (as long as the hot key driver is running in the taskbar).
Application Hot Key

To configure a program to open when the application hot key \( \text{ } \) button is pressed (Windows Media Player is the default program), follow the instructions below.

1. **Double-click** the Hot Key driver icon \( \text{ } \) in the taskbar.
2. **Click** Launch user specified application (button) \( \text{ } \).

3. An **Open** dialog box will appear on the screen.

4. **Browse** to the directory where the desired application.exe program exists.
5. **Double-Click** on the program file or choose **Open**, and click **OK** (button).
6. Press the application hot key button \( \text{ } \) to open the program.
Video Features

You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the video driver is installed. For further information see either “Intel Video Driver Controls” on page E - 9 or “NVIDIA Video Driver Controls” on page E - 13.

1. Click Start, point to Settings and click Control Panel (or click Control Panel).
2. Double-click Display (icon); Display (icon) is in the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen resolution.
5. Click the arrow, and scroll to the preferred setting in Color quality.
6. Open the Display Properties control panel, and click Advanced (button) to bring up the Advanced properties tabs.

For Intel GMA
1. Click Intel(R) Graphics Media Accelerator (tab) (Figure E - 7 on page E - 8).
2. Click Graphics Properties (button) to access the Intel GMA control panel.
3. The Intel GMA control panel can also be accessed by clicking the icon in the taskbar and selecting Graphics Properties from the menu.

For NVIDIA GeForce Go
1. Click GeForce Go 7600 (tab) (Figure E - 7 on page E - 8).
2. Click Additional Properties (or click the icon ) to make any video adjustments.
3. The GeForce Go 7600 can also be accessed by right-clicking the desktop, and then clicking NVIDIA Display > Laptop Display.
4. You can also access NVIDIA nView Desktop Manager from the Windows Control Panel (see page E - 10).
Windows XP Information

Figure E - 7 - Display Properties

E - 8 Video Features
Intel Video Driver Controls

Video Driver Installation
To access the Intel Graphics Media Accelerator Driver Controls you must install the video driver as indicated below). Make sure you install all the drivers in the order indicated in Table E - 2, on page E - 21.

Intel Video
1. Click 2.Install Video Driver > Yes.
   OR
   Navigate (Browse...) to
   X:\Drivers\01VGA\Intel\Setup.exe and click OK.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Dynamic Video Memory Technology
This system features Intel® Dynamic Video Memory Technology. Intel® DVMT automatically and dynamically allocates as much (up to 376MB) system memory (RAM) as needed to the video system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system. You can define the amount of system memory to be allocated from the BIOS (see “IGD Memory Size (Advanced Menu > Advanced Chipset Control)” on page 5 - 9).
Intel GMA Control Panel

You can also access the Intel(R) Graphics Media Accelerator Driver from the Windows control panel.

Taskbar Icon

The Intel GMA control panel can also be accessed by clicking the icon 🗄️ in the taskbar and selecting Graphics Properties from the menu.

If you cannot see the tray icon click the “Show Tray Icon” tickbox in the Intel(R) Graphics Media Accelerator Driver tab.

Figure E - 8
Intel GMA Driver
Windows Control Panel
You may make changes to the color, schemes, **Hot Keys** etc. by clicking the appropriate menu item or button. Click **Information** (button) to obtain useful information about the graphics properties of the computer, and see the **Support** tab in **Information** to get weblinks to the latest information on the Intel Website.

**Help Menus**
Right-click on many of the items in the tabs to bring up the “What's This?” button.
Click the “What's This?” button to bring up the help menu.

**Figure E - 9**
Intel Graphics Media Accelerator Driver (Control Panel Tabs)
Scheme Options
Use Scheme Options to configure quick settings for applications which require specific resolution and color settings in order to run properly e.g. games, multimedia programs. To set the scheme options:

1. Open the Intel(R) GMA Driver for Mobile control panel.
2. Configure your display configuration, resolution etc. as per your requirements from Display Settings.
3. Click on Scheme Options (button).
4. Type a name for the scheme.
5. If you want to automatically launch an application when running the scheme click on Browse (button).
6. Browse to the executable file for the application you want to set the scheme for (see sidebar), and click Open to select it.
7. Click Save to save the settings (you can click in the "Restore the display settings after exiting this application" box to return to your original settings when you exit the program).
8. Click OK to exit Scheme Options.
9. Click the taskbar icon and scroll to Select Scheme to choose the scheme to run.

Application.exe
You will need to locate the actual application executable (.exe) file, not just the shortcut. To find the application right-click its shortcut on the desktop click Properties. Click the Shortcut (tab) and see where the executable file is located by clicking the Find Target (button). Note the location and you will then be able to browse to this file.

Figure E - 10
Select Scheme
NVIDIA Video Driver Controls

Video Driver Installation
To access the NVIDIA GeForce Go controls you must install the video driver as indicated below. Make sure you install all the drivers in the order indicated in Table E - 2, on page E - 21.

1. Click **Install Video Driver > Yes**.
2. Click **Next**.
3. Click to select **Yes, I want to restart my computer now**.
4. Click **Finish** to restart the computer.

Additional Properties
More advanced video configuration options are provided in the GeForce Go 7600 control panel tab. The items listed in the Additional Properties window allow you to configure your display(s). If the items do not display you can either click the Additional Properties button, or click the icon.

You may make changes to the Display Settings, Color Correction, Video Overlay, Resolutions, Refresh Rates and Screen Rotation by clicking the appropriate tab and adjusting the setting. Some screen examples are shown on the following page.
Help Menus

Right-click on many of the items in the tabs to bring up the “What’s This?” button.

Click the “What’s This?” button to bring up the help menu.

Figure E - 11
Screen Examples

Right-click on a control panel item to bring up a Help menu (see sidebar).
NVIDIA nView Desktop Manager

The nView Desktop Manager allows quick access to control panels for features such as Desktop Management, Profiles, Hot Keys etc. The Control panel may be accessed as follows.

1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click NVIDIA nView Desktop Manager (icon) - Click "Switch to Classic View" from the left of the menu if you are in Category View.

Click the Enable button to display the Desktop Management options menu.

You can view the nView Desktop Manager control panels from the Additional Properties window.

Select Additional Properties from the GeForce Go 7600 control panel. Click the Desktop Management menu item and click the Enable button to display the options.

Figure E - 12
Desktop Manager Control Panel
Power Management

The computer uses the ACPI power management system to conserve power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system.

Using some form of power management greatly increases the life span of the LCD.

When the computer is on, you can use the power button as a Standby/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Note that if you have included the Hybrid TV Tuner in your purchase option, you may use the supplied remote control to send the computer into a power saving state.

---

Shutdown

Note that you should always shut your computer down by choosing the Shut Down/Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.

Forced Off

If the system "hangs", and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.
Power Schemes
You can set your computer to conserve power through individual components by means of **Power Schemes**. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter **Standby** or **Hibernate** modes (see “**System Power Options**” on page **E - 18**).

Choose the **Home/Office Desk** scheme for maximum performance.
Windows XP Information

System Power Options
You can use the system power options to stop the computer’s operation and restart where you left off. This system features Standby and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power Options control panel - Figure E - 14 on page E - 19).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on standby instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Standby mode.
Standby
Standby saves the least amount of power, but takes the shortest time to return to full operation. During Standby the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Standby mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

System Resume
The system can resume from Standby mode by:
- Pressing the power button
- An alarm resume that is enabled and expires
- An incoming call received on the modem (if enabled)
- Network card activity (if enabled)

Figure E - 14
Enable Hibernation
Configuring the Power Button

The power button may be set to send the computer into either Standby or Hibernate mode. In Standby mode, the Power LED will blink green. In Hibernate the LED will be orange. If the only the display is turned off, the LED will remain green.

Figure E - 15
Power Options
(Advanced - Power Buttons)
Driver Installation

The *Device Drivers & Utilities + User’s Manual CD-ROM (WinXP)* contains the drivers and utilities necessary for the proper operation of the computer. The table opposite lists what you need to install, and it is very important that the drivers are installed in the order indicated.

Only install drivers for modules (WLAN, Bluetooth, and PC Camera) included in your purchase option.

**Installation Methods (Win XP)**
You may choose to install the drivers from the *autorun program*, or install them manually.

<table>
<thead>
<tr>
<th>WinXP SP2 Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the appropriate Service Pack for WinXP</td>
<td>Page E - 23</td>
</tr>
<tr>
<td>Chipset</td>
<td>Page E - 24</td>
</tr>
<tr>
<td><em>Intel</em> Video</td>
<td>Page E - 25</td>
</tr>
<tr>
<td><em>NVIDIA</em> Video</td>
<td>Page E - 25</td>
</tr>
<tr>
<td>Audio</td>
<td>Page E - 25</td>
</tr>
<tr>
<td>Modem</td>
<td>Page E - 26</td>
</tr>
<tr>
<td>LAN</td>
<td>Page E - 26</td>
</tr>
<tr>
<td>CardReader</td>
<td>Page E - 27</td>
</tr>
<tr>
<td>JMicron</td>
<td>Page E - 27</td>
</tr>
<tr>
<td>Hot Key (for Brightness and Application Hot Keys)</td>
<td>Page E - 27</td>
</tr>
<tr>
<td>Intel Matrix (for SATA RAID &amp; AHCI)</td>
<td>Page E - 50</td>
</tr>
<tr>
<td>Wireless LAN</td>
<td>Page E - 28</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>Page E - 33</td>
</tr>
<tr>
<td>ITE CIR (Infrared Remote Control)</td>
<td>Page E - 35</td>
</tr>
<tr>
<td>Hybrid TV Tuner</td>
<td>Page E - 37</td>
</tr>
<tr>
<td>PC Camera</td>
<td>Page E - 38</td>
</tr>
<tr>
<td>Wireless Kit</td>
<td>Page E - 43</td>
</tr>
</tbody>
</table>

*Table E - 2 - Driver Installation*
What to Install

This section covers driver and utility installation instructions for Windows XP Home/Professional & Media Center Edition. Insert the Device Drivers & Utilities + User’s Manual CD-ROM and click Install Drivers (button)/Optional (button). Alternatively Click Start and navigate (Browse..) to follow the manual setup instructions.

1. Check the driver installation order from Table (all the drivers must be installed in this order) which is the same as that listed in the Drivers Installer menu below.
2. Click to select the driver you wish to install, after installing each driver it will become grayed out (if you need to reinstall any driver, click the Unlock button).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure E - 16 - Drivers Installer Screen 1

Figure E - 17 - Drivers Installer Screen 2
**Updating/Reinstalling Individual Drivers**

If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the *Windows OS* and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click "+").
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.

---

**Windows XP Service Pack 2**

Make sure you install *Windows XP Service Pack 2* (or a Windows XP version which includes Service Pack 2) before installing any drivers. Service Pack 2 includes support for USB 2.0.

If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:

1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click "+" next to Other Devices (if its sub-items are not shown).
5. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.
Windows XP Information

New Hardware Found
If you see the message “New Hardware Found” (Found New Hardware Wizard) during the installation procedure (other than when outlined in the driver install procedure), click Cancel to close the window, and follow the installation procedure as directed.

Driver Installation Procedure
Note that X is the drive letter assigned to the CD/DVD-ROM drive.

Chipset
1. Click 1.Install Chipset Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Drivers\00Chipset\Setup.exe and click OK.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Windows XP USB Error
After installing the Intel Chipset Software on the computer, USB devices may no longer work correctly. When this problem occurs, a yellow exclamation mark may appear next to the USB devices in Device Manager.

This problem occurs because of a timing conflict between Windows File Protection and the Setup program.

A supported hotfix is now available from Microsoft Product Support Services. For a complete list of Microsoft Product Support Services telephone numbers and information about support costs, visit the following Microsoft Web site:

http://support.microsoft.com/contactus/?ws=support
OR
http://support.microsoft.com/kb/921411/en-us
Intel Video
1. Click 2. Install Video Driver > Yes.
   OR
   Navigate (Browse...) to
   X:\Drivers\01VGA\Intel\Setup.exe and click
   OK.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

NVIDIA Video
1. Click 2. Install Video Driver > Yes.
   OR
   Navigate (Browse...) to
   X:\Drivers\01VGA\Nvidia\Setup.exe and click
   OK.
2. Click Next.
3. Click to select “Yes, I want to restart my com-
   puter now”.
4. Click Finish to restart the computer.

Audio
1. Click 3. Install Audio Driver > Yes.
   OR
   Navigate (Browse...) to
   X:\Drivers\02Audio\Setup.exe and click OK.
2. Click Next > (click Cancel if a Found New
   Hardware Wizard appears).
3. Click Finish to restart the computer.
### Windows XP Information

#### Modem
1. Click 4. Install Modem Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Drivers\03Modem\setup.exe and click OK.
2. Click OK.
3. The modem is ready for dial-up configuration.

#### LAN
1. Click 5. Install LAN Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Drivers\04LAN\Setup.EXE and click OK.
2. Click the button to accept the license, and then click Next > Next.
3. Click Install Drivers (button).
4. Click Next.
5. Click the button to accept the license, and then click Next > Next > Install.
6. Click Finish > Exit.
7. The network settings can now be configured.

---

**Modem Country Selection**

Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).
Windows XP Information

CardReader
   OR
   Click Start (menu) > Run... and navigate (Browse...) to
   X:\Drivers\05CReader\setup.exe and click OK.
2. Click Next.
3. Click the button to accept the license, and then click Next.
4. Click Finish.

JMicron (for E-SATA)
1. Click 7.Install JMicron Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to
   X:\Drivers\06JMicron\setup.exe and click OK.
2. Click Next > Next > Install.
3. Click Finish to restart the computer.

Hot Key
1. Click 8.Install Hotkey Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to
   X:\Drivers\07HotKey\Setup.EXE and click OK.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.

Module Drivers
See the pages indicated in Table E - 2, on page E - 21 for the driver installation procedures for any optional modules included in your purchase option.
Wireless LAN Modules

If you have included either an Intel PRO/Wireless 3945ABG (802.11a/b/g) PCIe WLAN module, or 802.11b/g USB WLAN module, in your purchase option the ♻ LED will be green. Install the appropriate driver for your module indicated in “Intel WLAN Driver Installation” on page E - 29 OR “802.11 b/g USB Wireless LAN Driver Installation” on page E - 30.
Intel WLAN Driver Installation

1. Insert the *Device Drivers & Utilities + User’s Manual CD-ROM (WinXP)* into the CD/DVD drive.
2. Click **Optional** (button), and then click **2.Wireless Lan > Yes.**
   OR
   (Click **Start** (menu) > **Run...** and navigate (**Browse..**) to
   X:\Others\02WLan\Intel\Autorun.exe and click **OK**.
3. Click **Install Software** (button).
4. Click the button to accept the license and click **Next > Next > OK**.
5. Click **OK** to complete the installation.
6. Configure the settings from the **Intel (R) PROSet Wireless** control panel
   (**Start** > **Programs/All Programs** > **Intel PROSet Wireless**), or double-
   click the taskbar icon 📋.

*Figure E - 18
Intel PROSet/Wireless*
802.11 b/g USB Wireless LAN Driver Installation
1. Insert the *Device Drivers & Utilities + User’s Manual CD-ROM (WinXP)* into the CD/DVD drive.
2. Click *Optional* (button), and then click 2.Wireless Lan > Yes.
   OR
   (Click *Start* (menu) > *Run...* and navigate (*Browse..*) to X:\Others\02WLn\AzureW\Setup.exe and click OK.
3. Click *Next*.
4. Click *Finish* to complete the installation.
5. The operating system is the default setting for Wireless LAN control in *Windows XP*.
6. Access any available wireless networks from the *Network Connections* control panel in *Windows* (Start > Settings > Network Connections OR Start > Connect To > Show all Connections) or by clicking the taskbar icon.

*Figure E - 19 - Wireless Network Control Panels*
Peer to Peer Network Setup

When setting up a Peer to Peer network connection in WinXP please follow the instructions below to set up a static IP:

1. Click Start and go to Connect to > Show all connections (Start > Settings > Network Connections).
2. Double-click Local Area Connection.
3. Click Internet Protocol (TCP/IP), and then double-click Properties.

![Figure E - 20 - Local Area Connection Properties](image-url)
4. Click *Use the following IP address*; and type in static IP address e.g. 192.168.1.1.
5. Click **OK**, and close all the control panels.
6. Restart the computer and connect the computers with the appropriate network cable etc.
Bluetooth Module

If you have included a Bluetooth module in your purchase option the 📠 LED will be orange.

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM (WinXP) into the CD/DVD drive.
2. Click Bluetooth > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Others\03Bluetooth\Setup.exe and click OK.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click the button to accept the license agreement, and then click Next.
6. Click Next > Next > Install.
7. Click Finish.
8. You can configure the settings at any time by going to the IVT Corporation BlueSoleil - Main Window control panel (Start > Programs/All Programs > IVT BlueSoleil), or by clicking the taskbar/desktop icon 📠.
User Guide

View the BlueSoleil User Guides (Contents and Index) from the Help menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel. Click BlueSoleil User Guides in the Contents tab, and click to select the appropriate User Guide from the panel on the right.

Figure E - 22
Bluetooth Control Panel & User Guides
Remote Control Unit

If your purchase includes the optional TV Tuner module you will be provided with a remote control unit. You need to install the consumer infrared driver to enable all the remote control unit functions.

The remote control unit allows to remotely start and shutdown the system, to run Windows Media Center and navigate the Media Center menus etc. The remote control unit also gives full control over all TV and video functions.

Consumer Infrared Driver Installation

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM (WinXP) into the CD/DVD drive.
2. Click Optional.
3. Click Install ITE CIR > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Others\04CIR\setup.exe and click OK.
4. Click Next > Yes > Next.
5. Click Finish > Finish to restart the computer.
**Windows XP Information**

*Figure E - 23*

**Remote Control Unit**

1. Sleep Button
2. My TV
3. My Music
4. My Pictures
5. My Videos
6. Stop
7. Record
8. Pause
9. Play
10. Rewind
11. Fast Forward
12. Replay
13. Skip
14. Back
15. More (Information)
16. Cursor Keys & OK (Used to Navigate Media Center Menus)
17. Volume
18. Channel Change
19. Start (Starts *Cybelink PowerCinema*)
20. Mute
21. Recorded TV
22. Guide
23. Live TV
24. DVD Menu
25. Number Pad
26. Clear
27. Enter
Hybrid Mini-PCI TV Tuner Module

The instructions for installing the Hybrid Mini-PCI TV Tuner Module driver and Cyberlink PowerCinema application are provided below (see “Hybrid Mini-PCI TV Tuner Module” on page 7 - 15 for further information).

Installing the MPC788 Driver & Cyberlink PowerCinema

1. Insert the driver *MPC788 CD-ROM* into the CD/DVD drive.
2. Choose the Setup Language you prefer, and then click **Next**.
3. Click **Next > Next**.
4. Click the button to accept the license agreement for *Microsoft(R) DirectX(R)*, and then click **Next > Next > Finish**.
5. Click **Next > Yes**.
6. Type in the *Cyberlink PowerCinema* CD Key provided (make sure you also input a User and Company Name), and then click **Next**.
7. Click **Next > Next > Next > Finish**.
8. Click **Next > Install > Finish** to install SimHID.
9. Click **Finish** to restart the computer.
10. Run the application from the **Start > Programs/All Programs > Cyberlink PowerCinema** and select the **PowerCinema** program, or double-click the icon on the desktop.
11. **Help** is available from within the **PowerCinema** program.
PC Camera Module

If you have included a PC Camera module in your purchase option, install the driver as indicated below.

PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM (WinXP) into the CD/DVD drive.
2. Click Optional.
3. Click 5.PC Camera, Web cam > Yes
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Others\05Camera\Setup.exe and click OK.
4. Choose the language you prefer and click OK.
5. Click Next > Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the desktop, or from the BisonCam item in the Start > Programs/All Programs menu.

Latest PC Camera Driver Information

Check the PC Camera CD, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows.

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer Device menu.
5. Click Mic Volume (check box) if it is not checked, then click OK.
6. Boost the volume as high as it will go in Recording.
7. Close the window, and then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Figure E - 24
Audio Setup
(Windows XP)
Bison Cap

**BisonCap** is a video viewer useful for general purpose video viewing and testing, and can capture video files to .avi format.

1. Run the **BisonCap** program from the **Start > Programs/All Programs > Bison-Cam** menu (it is recommended that you **set the capture file** before the capture process - **see Set Capture File below**).
2. Go to the **Capture** menu heading (if you wish to capture audio check “**PC Camera Audio Setup**” on page E - 39) and select **Start Capture**.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (**see the sidebar - Pre-Allocating File Space**) for the captured file. Click **Start Capture** again.
4. Click **OK** to start capturing the video, and press **Esc** to stop the capture.
5. If you wish to, you may go to the **File** menu and select **Save Captured Video As...**, choose a file name and location, and then click **Open** (you can view the file using the **Windows Media Player**).

Set Capture File

In the **BisonCap** program you will only be asked to set the capture file name on the first run of the program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the **Set Capture File..** option in the **File** menu, and set the file name and location before capture. Set the name and location then click **Open** (you can choose **Cancel** to ignore the file size if prompted).

---

**Pre-Allocating File Space**

You may pre-allocate the file size for the capture file in the **BisonCap** program. You can choose to ignore this by clicking **Cancel**.

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

You may find it helpful to defragment the HDD before capture.
Eliminating Screen Flicker

If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure E - 25
Video Capture Filter
Wireless Keyboard & Mouse Kit

If you have included the RF wireless keyboard and mouse kit in your purchase option, a quick installation guide is provided to guide you through setting up the system. However, first see the hardware setup instructions on Page 7 - 23, then install the Windows XP driver as indicated below.

Wireless Kit Driver

1. Make sure the module is powered on, and then insert the Device Drivers & Utilities + User’s Manual CD-ROM (WinXP) into the CD/DVD drive.
2. Click Optional.
3. Click 6.Install WKit Driver > Yes.
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Others\06WKit\SetupKey.exe and click OK.
4. Click the button to install the driver.
5. Click OK.
6. Double-click the taskbar icon (or right-click the icon and select Configure) to access the control panel.
7. A full Help menu is available from the control panel.
Windows XP Information

Setting Up SATA RAID or AHCI Modes

RAID Mode
If your purchase includes the RAID (Redundant Array of Independent Disks) option, the following pages provide an introduction to configuring your hard disks in RAID mode. A RAID requires two hard disks, and you may use your hard disks in combination with Striping (RAID 0) or Mirroring (RAID 1) for either fault tolerance or performance.

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>Identical drives reading and writing data in parallel to <em>increase performance</em>. RAID 0 implements a striped disk array and the data is broken into blocks and each block is written to a separate disk drive.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Identical drives in a mirrored configuration used to <em>protect data</em>. Should a drive that is part of a mirrored array fail, the mirrored drive (which contains identical data) will handle all the data. When a new replacement drive is installed, data to the new drive is rebuilt from the mirrored drive to restore fault tolerance.</td>
</tr>
</tbody>
</table>

*Table E - 3 - RAID Levels*

AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows the storage driver to enable advanced Serial ATA features such as Native Command Queuing (for maximum hard disk efficiency and performance). AHCI mode can be supported by one or two hard disks.
Prepare the following before setting up your Serial ATA hard disks in RAID or AHCI mode:

1. An operable computer with a floppy drive (to create a SATA RAID/AHCI driver diskette).
3. An external USB floppy disk drive.
4. The Microsoft Windows OS CD.
5. A prepared formatted blank 3.5” 1.44MB floppy diskette.
6. The second hard disk (required for RAID but not required for AHCI) installed in the optional device drive bay (see page 6 - 3).

**RAID Array Types**

A Mirrored Array (RAID 1) provides full data protection, as data can simply be copied from a healthy disk to a replacement for any failed disk.

A Striped Array (RAID 0) is NOT fault-tolerant. The failure of one drive will result in the loss of all data in the array. It is designed to increase disk performance by spreading the I/O load across the channels and drives.
SATA RAID or AHCI Setup Procedure (BIOS)

1. Go to the operable computer running Windows XP and insert a prepared formatted blank 3.5" 1.44MB floppy diskette.
3. Click Start (menu) > Run... and navigate (Browse..) to D:\Others\00RAID\F6f1py32.exe and click OK.
4. Make sure the formatted blank 3.5" 1.44MB floppy diskette is inserted, and click OK.
5. A SATA RAID/AHCI driver diskette will now be created for you.
6. Remove the SATA RAID/AHCI driver diskette.
7. Start-up your computer and press <F2> to enter the BIOS.
8. Go to the Advanced menu.

   • For RAID Mode: - Set "SATA RAID Enable" ("SATA RAID Enable: (Advanced Menu)" on page 5 - 9) to "Enabled".

   OR

   • For AHCI Mode: - Set "SATA AHCI Enable" ("SATA AHCI Enable: (Advanced Menu)" on page 5 - 9) to "Enabled".

9. Press Esc and go to the Boot menu.
10. Set the external CD/DVD-ROM Drive (make sure the Microsoft Windows OS CD is inserted) as the first device in the boot order from the Boot menu.
11. Attach the external USB floppy disk drive to one of the computer’s USB ports.
12. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and press Enter to exit the BIOS and reboot the computer.
For RAID Only (for AHCI Mode go to "Windows Setup for RAID & AHCI Modes" on page E - 49)

1. Press Ctrl + i to enter RAID configuration menu.

3. Specify the RAID volume name and then press Tab or Enter to advance to the next field.
4. Specify the RAID level (RAID 0 or RAID 1 - see Table E - 3, on page E - 44 and "RAID Array Types" on page E - 45) and then press Tab or Enter to advance to the next field.
5. Press Enter and the system will select the physical disks to use.

Figure E - 27 - Intel(R) Matrix Storage Manager
6. Press Enter and select the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to Create Volume.
9. Confirm the selection by pressing Y.
10. This will now return to the main menu.

11. Select **4. Exit** and press Enter, then press Y to exit the RAID configuration menu.

**Figure E - 28 - RAID Created**

---

**E - 48 Setting Up SATA RAID or AHCI Modes**
Windows Setup for RAID & AHCI Modes

12. Start the computer up, and press a key when you see the message "Press any key to boot from CD".
13. Press the F6 key when you see the message "Press F6 if you need to install third party SCSI or RAID driver".
14. When the Windows Setup menu appears (Windows will load a number of files before the Setup menu appears), press the <S> key to "Specify Additional Device".
15. Insert the SATA RAID driver diskette into the external USB floppy drive, and press Enter.
16. Use the arrow keys to scroll down and select (see below):

<table>
<thead>
<tr>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>For RAID Mode</td>
</tr>
<tr>
<td>Intel(R) 82801HR/HH/H0 SATA RAID Controller (Desktop ICH8R)</td>
</tr>
<tr>
<td>Intel(R) 82801HR/HH/H0 SATA AHCI Controller (Desktop ICH8R)</td>
</tr>
<tr>
<td>Intel(R) 631xESB/632xESB SATA RAID Controller (Server/Workstation ESB2)</td>
</tr>
<tr>
<td>Intel(R) 631xESB/632xESB SATA AHCI Controller (Server/Workstation ESB2)</td>
</tr>
</tbody>
</table>

17. After you have selected the appropriate option, press Enter.
18. The system will now read from the floppy disk drive and then return to the Windows Setup menu.
19. Press Enter to continue installing the operating system as normal (see your Windows documentation if you need help on installing the Windows OS).
20. Install the Windows drivers as per Table E - 2, on page E - 21, and then install the Intel Matrix driver (see overleaf).
Windows XP Information

Intel Matrix Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual CD-ROM (WinXP) into the CD/DVD drive.
2. Click Optional.
3. Click 1.Install Intel Matrix > Yes
   OR
   Click Start (menu) > Run... and navigate (Browse...) to X:\Others\01Matrix\iadata_cd.exe and click OK.
4. Click Next > Next > Yes > Next
5. Click Finish to restart the computer.
6. Run the Intel(R) Matrix Storage Manager application from the Start > Programs/All Programs menu.

![Figure E - 30 - Intel Matrix Storage Console](image)

7. The Intel(R) Matrix Storage Manager provides information on the RAID status.